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 Installation Instructions 
for TC-1 Turbo Controller  

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR SALE 
OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES. 

  

OVERVIEW 
The TC-1 Turbo Controller P/N 118001 is 

intended for professional racing applications.  

 Flexible turbo control system adaptable to most 
turbocharged vehicle. 

 Open and closed loop control modes. Includes 
programmable duty cycle or boost curves based on 
RPM, vehicle speed and or time. 

 Closed loop control implements full proportional-
integral-derivative (PID) control loop with access to 
all parameters. 

 Compatible with most boost control solenoid valves.  

 Built-in 4-bar MAP sensor. User selectable units    
(In-Hg, kPa, or psi). 

 Bright transflective LCD display with backlight is 
readable in direct sunlight. 

 Built-in data logging capability with 16 Mbit 
DataFLASH memory. Rates ranging from 2 
samples/sec for 5 hours to 100 samples/sec for 6 
minutes.  

 Logs boost (MAP), RPM, vehicle speed, throttle 
position, solenoid duty cycle, battery volts, and two 
0-5V analog inputs.  

 0-5V analog inputs are compatible with Daytona 
Sensors single or dual channel WEGO units for 
logging wide-band air/fuel ratio data. 

 Programmable general purpose input/output can be 
used for an external scramble switch or to control a 
water/methanol injection system. 

 USB interface to PC. Windows software for data 
logging and advanced setup functions.  

 Heavy duty industrial grade clamping terminal blocks 
allow easy and reliable hookup without soldering or 
crimping.  

 Compact size: 4-1/2”L x 3”W x 1”H. 

ADDITIONAL REQUIRED PARTS 
The TC-1 comes with a USB cable and software 

on CDROM. Depending on your application, you may 
require wire, crimp terminals, and other electrical parts 
such as fuses, switches, and relays to complete the 
installation. If you are adding the TC-1 to an existing 
turbocharger system installation, you may already have 
most of these items but some rewiring may be 
required. The Appendix includes a list of recommended 
parts and suppliers. 

You will require a suitable boost control solenoid 
valve if your vehicle does not already have one 
installed. You can use our P/N 118002. Unlike some 
competitors that use a cheap valve imported from  
China, we use a genuine MAC valve with Viton seals 
intended for automotive boost control applications.   

Throttle position sensor (TPS), RPM, and 
vehicle speed sensor (VSS) signal connections are 
required to utilize all the capabilities of the TC-1. You 
will require a vehicle wiring diagram to locate these 
signal connections.  

 

Figure 1 – Typical TC-1 Installation 
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WIRING OVERVIEW 

10 Position Clamping Terminal Block Signals (Refer to Figure 2) 

1 (right) +12V 
Continuous 
Battery 
Power 

Connects to continuous battery power (always on) via a fuse  

2 +12V 
Switched 
Power 

Connects to ignition switch  

3 RPM Connects to RPM signal from ECM or coil. Signal level set by 
3-position jumper at right (refer to page 11 for details) 

4 VSS Connects to vehicle speed sensor signal 

5 TPS Connects to throttle position sensor. Connect to +12V on pin 2 
if not used. 

6 VIN1 Connects to 0-5V analog signal. Used for data logging only  

7 VIN2 Connects to 0-5V analog signal. Used for data logging only  

8 GPIO General purpose input/output 

9 Solenoid Connects to boost control solenoid valve 

10 (left) Ground Connects to chassis ground 

 
INSTALLATION 
1. Turn off the ignition switch and disconnect the 

battery ground cable before proceeding. 

2. Select a convenient mounting location for the TC-1 
unit. The unit is not waterproof and must be 
mounted in a dry location. The unit is not intended 
for underhood mounting. Optimum viewing angle is 
with the LCD slightly below eye level. The unit can 
be mounted with Velcro material. Convenient 
mounts, such as the cup holder mount shown in 
Figure 1 are available from RAM Mounting 
Systems (www.ram-mount.com).   

3. Refer to Figure 2 for basic hookup. All signal and 
power connections can be made with 18-20 AWG 
wire. 16 AWG wire should be used for the ground 
connection.  

4. Power, ground, solenoid, and manifold pressure 
connections are required for all applications. RPM, 
throttle position (TPS), and vehicle speed (VSS) 
connections are required to utilize the full 
capabilities of the TC-1. Optional connections for 
the general purpose input/output (GPIO), and 

analog inputs (VIN1 and VIN2) are shown in 
Figures 3 and 4.   

5. Working with the clamping terminal block. All 
connections to the TC-1 terminal block must be 
clearly identified either by means of distinct wire 
colors or the use of wire labels. If you use distinct 
wires colors, mark up Figure 2 for future reference. 
Refer to the Appendix for recommended wire 
labels. Wire should be stripped back 3/16-1/4 inch. 
No bare wire should be visible outside the terminal 
block. Use a miniature flat screwdriver to tighten 
the screws. The terminal block is removable and 
can be pulled straight out by the wires.    

6. Manifold pressure connection. Using a joiner 
fitting and appropriate rubber or silicone hose (1/8” 
ID recommended), connect the 3/32” ID manifold 
pressure hose from the TC-1 to an appropriate 
fitting on the intake manifold. You can also use a 
“T” fitting to connect to an existing hose.    
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Figure 2 – Basic TC-1 Hookup 
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Figure 3 – TC-1 GPIO Hookup Options 
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7. Throttle position sensor (TPS) signal. This 
connection is required to utilize the full capabilities 
of the TC-1. Most vehicles manufactured since 
1981 will have a TPS with 0-5V output located on 
the throttle body. Refer to the vehicle wiring 
diagram for details. You can check the TPS signal 
with a DVM. Some late model vehicles with drive-
by-wire electronic throttle bodies will have a dual 
output accelerator pedal sensor. The signal 
voltage on one output will rise with increasing 
pedal position and the other output will drop. 
Connect the TC-1 TPS input to the rising signal. 
Solder this signal connection and wrap with self 
vulcanizing electrical tape (refer to the Appendix). 
If a suitable 0-5V signal is not available, you can 
use a wide open throttle switch as shown in Figure 
2. If the TPS input is not used, connect it to 
switched +12V.   

8. RPM signal. This connection is required to utilize 
the full capabilities of the TC-1. Depending on your 
vehicle type and engine control, there are three 
possible sources for the RPM signal: 

a. High level signal on the Coil- terminal of 
most inductive discharge type ignitions. 
This includes most original equipment (OE) 
ignitions except coil-on-plug with integrated 
drive electronics. For distributorless systems 
with multiple coils or coil packs, you can use 
any one of the Coil- signals. Refer to the 
vehicle wiring diagram for details. The Coil- 
terminal will connect to an ignition module or 
engine control module (ECM). The Coil+ 
terminal will connect to switched +12V. 

b. Tach signal (preferred for best noise 
immunity). The TC-1 is compatible with 
industry standard 12V square wave tach 
signals such as what would be used to drive 
an Autometer or similar aftermarket tach. Most 
aftermarket capacitive discharge (CD) ignitions 
including the Daytona Sensors CD-1, MSD-6 
and Crane HI-6 series have a tach output that 
you can use.  

c. Low level logic signal. This type of signal is 
found on late model vehicles, including many 
imports, that use coil-on-plug with integrated 
drive electronics. Refer to the vehicle wiring 
diagram for details. You can use the signal that 
goes from the ECM to any one of the coil-on-
plug units.  

Unless you are using the tach terminal on an 
aftermarket ignition or a screw terminal on a coil, 
you should solder the RPM signal connection and 

wrap with self vulcanizing electrical tape (refer to 
the Appendix). During initial setup, you must 
configure the RPM signal level jumper on the right 
side of the TC-1. Refer to the Initial Setup section 
on page 11 for details.  

9. Vehicle speed sensor (VSS) signal. This 
connection is required to utilize the full capabilities 
of the TC-1. Most vehicles manufactured since 
1981 will have a VSS. Refer to the vehicle wiring 
diagram for details. Some late model vehicles with 
anti-skid braking (ABS) and electronic stability 
control (ECS) systems utilize individual wheel 
sensors used to calculate an average vehicle 
speed and in many cases this signal is available. 
You can also install a driveshaft sensor (contact 
tech support for details).  

10. Optional general purpose input/output (GPIO) 
signal. Refer to Figure 3 for GPIO hookup options. 
If you use the GPIO as a data logging input, you 
should install the supplied 1N4007 diode to protect 
the input circuitry from any inductive voltage 
transients caused by solenoids (such as a line lock 
or trans brake) that may be part of the circuit. If you 
use the GPIO window switch feature to drive an 
external device that draws more than 1 amp 
current, you must use a relay as shown. Refer to 
the Appendix for recommended relays.  

11. Optional analog input signals. The TC-1 will log 
0-5V data on two analog inputs (VIN1 and VIN2). 
Uses include logging air/fuel ratio (AFR) from a 
wide-band sensor system such as the Daytona 
Sensors WEGO IIID shown in Figure 4. You can 
also use a single channel WEGO III connected to 
either analog input. All Daytona Sensors WEGO 
systems have the same AFR scaling and are 
compatible with the TC-1. 

WARNING: If GPIO1 is used as an input 
and some inductive device such as a 
solenoid is also part of the circuit, a 
diode is required to protect the input 
from transients. Failure to install the 
required diode will damage the TC-1 
and void the warranty. 
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Figure 4 – Analog Input Hookup to Daytona Sensors WEGO IIID Wide-Band System 
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Figure 5 – Boost Control Solenoid Valve Installation for Pressure Operated Wastegates  
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Figure 6 – Boost Control Solenoid Valve Installation for BMW Vacuum Operated Wastegates 
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12. Ground connection. Use 16 AWG wire. Keep the 

ground connection as short as possible. The 
ground connection must go to a chassis ground 
stud (you can usually find one under the dash or 
near the vehicle ECM). If you are using the analog 
inputs, use the same ground point for any 
associated devices in order to avoid signals errors 
due to a ground loop.        

13. Boost control solenoid valve installation. Figure 
5 shows installation for typical pressure operated 
wastegates found on most turbocharged 
applications. Figure 6 shows installation for a BMW 
application using vacuum operated wastegates. If 
you are using our P/N 1180002 valve, install the 
supplied pneumatic muffler as shown. The function 
of the muffler is to protect the valve from ingress of 
dirt.     

14. Reconnect the battery ground cable. 

SPARK PLUGS AND WIRES 
To avoid electrical noise that may interfere with 

the TC-1 or other onboard computer and radio 
equipment, resistor spark plugs are recommended and 
spiral core RFI/EMI suppression type spark plug wires 
are required. Do not use solid copper spark plug wires. 
Optimum spark plug wire resistance is 50-500 ohms 
per foot, such as Taylor Vertex (www.taylorvertex.com) 
ThunderVolt 50 or 8.2mm spiral core.  
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TC-1 USER INTERFACE   

On initial power up, the TC-1 displays a graphics 
data screen shown in Figure 7 that includes the current 
operating mode and data. Elements include (from top 
to bottom): 

1. Operating mode. CLS LP MODE for closed loop 
mode or OPN LP MODE for open loop mode. In 
open loop mode the boost control solenoid runs at 
a set duty cycle. In closed loop mode, the boost 
control solenoid duty cycle varies and is reduced 
when the boost pressure exceeds the set point. 

2. Boost set point in closed loop or solenoid duty 
cycle in open loop. Example shows 280 kPa boost 
set point. 

3. Scramble (momentary higher boost or duty cycle 
level). Rotate the encoder knob clockwise (slowly) 
to turn on scramble mode. The SCRAMBLE legend 
appears. The scramble boost set point (in closed 
loop) or solenoid duty cycle (in open loop) 
becomes active for the scramble time and the 
higher value is displayed while scramble is active. 
You can rotate the encoder knob counterclockwise 
to immediately end scramble.  An external switch 
can also be wired up to the GPIO terminal to 
activate the scramble feature. 

4. Graph showing current manifold pressure. The 
graph starts at zero kPa. The 300 legend shows 
the full scale kPa value. The current manifold 
pressure value is displayed. Note that normal sea 
level pressure is about 101 kPa.  

5. Peak manifold pressure (example shows 202 kPa). 
The peak value is remembered. To clear the peak 
value, press the encoder knob to bring up the 
parameter entry screen and then press the knob 
again to return to the graphics data screen.     

Figure 7 – TC-1 Graphics Data Display 

Pressing the encoder knob while in the normal 
graphics data screen brings up the parameter entry 
screens shown in Figure 8. Parameters required for 
basic installation or quick on-vehicle adjustments can 
be set on this parameter entry screen. Advanced 
parameters, such as duty cycle or boost curves based 
on RPM, vehicle speed and or time and data logging 
setup are set via the USB interface and PC Link TC 
software.  

Rotate the encoder knob clockwise to highlight 
SELECT PARAM. Press the encoder knob to display 
and highlight the parameter number (0-15) as shown at 
the top of Figure 8. Parameters are listed in Table 1. 
Rotate the encoder knob clock wise or 
counterclockwise to scroll through the available 
parameters. The parameter name and value is 
displayed on the line above.  

To edit the selected parameter, press the 
encoder knob to highlight selected parameter and 
again to highlight the value as shown at the bottom of 
Figure 8. Rotate the encoder knob to edit the value. 
Press the encoder knob to save the value.  

To return to the graphics data display (Figure 7), 
rotate the encoder knob to highlight DATA DISPLAY 
and press the encoder knob.  

Figure 8 – TC-1 Parameter Entry Screens 

 

 

 

HINT: Rotate the encoder knob slowly. 
The TC-1 filters out rapid movements.  
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Table 1 – TC-1 Parameters 

Number Name Description 

0 CLS LOOP Sets closed loop mode. Values are YES or NO. Rotate encoder knob clockwise for YES or 
counterclockwise for NO. If NO is selected, the TC-1 will operate in open loop mode. In 
closed loop mode, the TC-1 will control solenoid valve duty cycle based on boost pressure. 
In open loop mode, the solenoid valve duty cycle will not vary with boost pressure. 

1 SCRAMBLE Values are YES or NO. Rotate encoder knob clockwise for YES or counterclockwise for NO. 
Select YES to enable scramble. 

2 BOOST SP Sets the boost set point in closed loop mode (scramble can be set higher) when no boost 
tables are enabled. 

3 DUTY CYC Sets the solenoid duty cycle in percent. In open loop mode, the boost control solenoid will be 
modulated at this duty cycle (scramble can be set higher) when no duty cycle tables are 
enabled. In closed loop mode, this is the initial estimate for duty cycle prior to closed loop 
correction based on manifold pressure. If the boost set point is exceeded, the duty cycle will 
be reduced to limit manifold pressure. 

4 SCRM SEC Sets the scramble timeout in seconds.

5 SCRM BST Sets the scramble manifold pressure in closed loop mode when no boost tables are 
enabled. 

6 SCRM DTY Sets the scramble solenoid duty cycle in percent. In open loop mode, the boost control 
solenoid will be modulated at this duty cycle when no duty cycle tables are enabled. In 
closed loop mode, this is the initial estimate for duty cycle prior to closed loop correction 
based on manifold pressure. If the scramble boost is exceeded, the duty cycle will be 
reduced to limit manifold pressure. 

7 P GAIN Sets the closed loop proportional gain (0-100). Higher values immediately reduce the boost 
error but may lead to boost instability. 

8 I GAIN Sets the closed loop integral gain (0-100). A zero value is appropriate for most drag race 
applications with short boost durations. For road race cars, some integral gain will reduce 
the boost error during prolonged periods of relatively steady boost and allow a lower value of 
proportional gain. 

9 D GAIN Sets the closed loop derivative gain (0-100). Higher values reduce boost spikes (overshoot 
of boost level during throttle roll-on). 

10 DEADBAND The boost control solenoid will remain energized (100% duty cycle) to bleed off feedback 
pressure until manifold pressure exceeds this value. A low value reduces boost spikes (the 
wastegate starts to open earlier) and a high value reduces turbo spool up time (the 
wastegate stays closed longer). 

11 SOL FREQ Sets the solenoid frequency in Hz. Normal values will be around 25 Hz. Large boost control 
solenoids used with twin turbo systems and external wastegates may require a lower 
frequency. 

12 OUT MODE Sets the solenoid output mode. Values are NORMAL or INVERT. Standard turbo systems 
used on most vehicles with the wastegate opened by boost pressure require the default 
NORMAL setting.  BMW turbo systems using vacuum to close the wastegate require the 
INVERT setting.  

13 GRAPH MAX Sets the maximum (full scale) graph value. The range is 150-400 kPa. 

14 CONTRAST Sets the display contrast. A higher value causes the display to appear darker.

15 DSP UNITS Sets the pressure units used for display (In-Hg, kPa, or psi). Note that all pressure data is 
absolute. IN, KPA, and PS are used as abbreviations for In-Hg, kPa, and psi respectively.   



 

 
Daytona Sensors LLC, 933 Beville Road, Suite 101-I, S. Daytona, FL 32119                                                 TC-1 
(386) 322-7390   www.daytona-sensors.com  5/2015 

 Page 11 

TC-1 GENERAL NOTES 
1. The TC-1 stores manifold pressure in kPA units. 

The manifold pressure sensor is a Motorola 
MPXH6400A. This is the most accurate sensor 
available with a range of 20-400 kPa.  

2. While the TC-1 supports display of data in psi and 
in-Hg (inches of mercury) manifold pressure units, 
kPa (kilopascals absolute) is the preferred unit now 
used throughout the automotive industry. KPa 
units are easy to deal with, since standard sea 
level atmospheric pressure is about 100 kPa. 
Precise values of standard sea level atmospheric 
pressure are: 29.92 in-Hg = 14.696 psia = 101.325 
kPa. 400 kPa (maximum pressure read by the TC-
1) is 118 in-Hg or 58 psia. 

3. The TC-1 uses absolute manifold pressure units 
(total vacuum would be 0 kPa). Using absolute 
pressure units is standard throughout the 
automotive industry and is important in any 
system with data logging, since it allows 
accurate comparisons between runs under 
different conditions. An engine running at 150 
kPa manifold pressure puts out the same 
horsepower at high elevation as at sea level. Older 
systems used “gauge pressure.” Gauge pressure 
is referenced to atmospheric pressure. 10 psig (psi 
gauge pressure) boost doesn’t give the same 
engine performance at Pikes Peak as in Death 
Valley.   

4. The TC-1 uses non-volatile DataFLASH memory 
for data logging. A continuous battery power 
connection is required for power down sequencing 
and proper storage of the last data logged by the 
unit. This process requires about 5 seconds. With 
the ignition key off, battery drain is only about 1 
microamp. Once the power down sequence is 
completed, data is not lost even if the battery is 
disconnected.      

TC-1 INITIAL SETUP AND 
OPERATION   

1. Complete the installation of the TC-1 following the 
steps described on pages 2-8. Skip any steps 
below that are not relevant to your application.  

2. Turn on the ignition key and verify that the TC-1 
display turns on. The unit should display 
atmospheric manifold pressure when the engine is 
not running. Turn off the ignition key. The display 
backlight should immediately go off and the display 
will blank out after about 2-3 seconds. This 
indicates proper power and ground connections.  

3. Temporarily connect a handheld vacuum/pressure 
pump such as Mityvac P/N 04050 or Sears 
Craftsman Model 14005 to the TC-1 manifold 
pressure line. With the ignition key on and positive 
pressure applied, verify that the boost control 
solenoid is clicking.  

4. Use of the PC Link TC and TC Log software 
programs is optional and not required for basic 
operation of the TC-1. However the TC Log 
software is very useful during initial setup as it is 
much easier and safer to download and examine 
data than trying to make observations while the 
vehicle is being operated. Use of the TC Log 
software is the only practical means of accurately 
tuning the system parameters for closed loop 
operation. If you plan to use the software, carefully 
read the material starting on page 14. Then install 
the USB driver and software before proceeding. If 
you will not be using the software, you can skip 
ahead to step 13.   

5. Connect the USB cable, start PC Link TC software, 
and open the TC1_Sample.dat setup file.  

6. RPM input setup. Refer to page 18 for RPM 
Pulses/Rev setting. Enter the setting 
corresponding to your application and upload to 
the TC-1. If you are not using the RPM input, use 
the default value and skip to step 10. 

7. Start the engine and let it run for about a minute at 
idle. Note the idle RPM on your tach. Start TC Log 
software, download data from the TC-1, and verify 
correct engine RPM trace on the chart (should 
show idle RPM value same as vehicle tachometer).  

8. If the RPM trace is incorrect (too high or too low) 
but not zero, you will need to change the RPM 
Pulses/Rev setting. Turn off the ignition switch in 
between tests. If the RPM trace is too low, use a 
lower RPM Pulses/Rev setting. If the RPM trace is 
too high, use a higher RPM Pulses/Rev Setting. 
Change the setting as required in PC Link TC and 
upload to the TC-1.  

9. If the RPM display is zero, you may need to 
change the RPM signal level jumper at the right 
corner of the TC-1. Turn off the ignition switch in 
between tests. The jumper has three positions 
labeled 5V, TACH, and COIL (refer to Figure 1). 
The default factory setting is in the COIL position 
(for a high voltage coil signal). Move the jumper to 
the TACH position (for a 12V  tach signal) and 
repeat the test. If the RPM display is still zero and 
your engine has coil-on-plug ignition, move the 
jumper to the 5V position (for a logic level signal). 
Do not attempt to use the 5V position for any 
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other type of ignition system. If the RPM display 
is still zero, call tech support. If required, go back 
to step 6 to establish the correct RPM Pulses/Rev 
setting. 

10. Throttle position sensor (TPS) input setup. If 
you are not using the TPS input, jumper it to +12V 
switched power and skip ahead to step 12. Turn on 
the ignition key, but do not start the engine. Use 
a DVM to measure the TPS voltage by probing 
between the TPS and ground terminals on the TC-
1. Write down the voltage levels for zero (closed) 
and 100% (wide open) TPS. Enter the zero and 
100% TPS values in the PC Link TC software and 
upload to the TC-1.  

11. Cycle the ignition key off/on but do not start the 
engine. Allow the TC-1 to log data for 30 seconds 
with the throttle closed and then again with the 
throttle wide open. Start TC Log software, 
download data from the TC-1, and verify correct 
TPS trace on the chart (should go from zero to 
100% as the throttle is opened).  

12. Vehicle speed sensor (VSS) input setup. Skip 
this step if you are not using the VSS connection. 
Establishing the correct VSS scale factor in PC 
Link TC will require some trial and error. Start with 
the default setting. Log speed data while operating 
the vehicle at a known speed. Use TC Log 
software and  download data from the TC-1 to read 
the logged speed data. Use the following formula 
to calculate the correct scale factor: 

      New VSS Freq  =  Original VSS Freq x Speed Reading                                 
          Actual Vehicle Speed 

For example, if the original VSS frequency 
parameter was 145 Hz, the speed reading is 40 
MPH and the actual vehicle speed is 50 MPH, then 
the new VSS frequency parameter should be: 

  116 Hz  =  145 Hz x 40 MPH                                 
               50 MPH 

You may have repeat this process several times 
for maximum accuracy.  

13. Test operation of the TC-1 in open loop mode. 
Proper operation in open loop and establishing a 
duty cycle value that will give the target boost 
value is key to operation of the unit. Start with 20% 
duty cycle and do a test run. Gradually increase 
the duty cycle in 5-10% increments until you reach 

the target boost pressure. Higher duty cycle values 
bleed off more of the wastegate pressure  and 
result in higher boost levels. The data logging 
feature is very helpful during this initial setup phase 
as you can quickly do test runs at different duty 
cycles and then download and analyze the data. 
Examine the MAP and Valve Duty traces on the 
chart. Repeat the above process for scramble 
mode. Note: BMW applications using vacuum 
operated wastegates and the invert output 
mode function in the opposite manner. Higher 
duty cycle values bleed off more of the vacuum 
that causes the wastegate to close and result in 
lower boost pressure. For BMW applications 
start at 80% duty cycle and gradually decrease 
the duty cycle.  

14. For closed loop operation, first carefully read the 
following section so that you understand the 
influence of proportional-integral-derivative (PID) 
control parameters. Then follow the steps in the 
section of tuning PID control parameters on page 
12.   

INFLUENCE OF PID CONTROL  
PARAMETERS   

For closed loop operation, the TC-1 implements 
a proportional-integral-derivative (PID) control 
algorithm that has been optimized for turbocharger  
applications. PID control is widely used in industrial 
control applications. For more background information, 
we suggest that you do a Google search on the term 
PID control.    

Figure 9 shows an idealized system response 
with manifold absolute pressure (MAP) rising to a 
setpoint of 200 kPa upon wide open throttle 
application.  

The system is said to underdamped if a 
considerable MAP overshoot (spike) or oscillation 
occurs. The system is said to be overdamped if MAP 
rises very slowly.  A critically damped system has a 
rapid rise with minimal overshoot. The ratio of 
derivative gain to proportional and integral gain has a 
significant effect on system response. Higher derivative 
gain increases damping and reduces overshoot.   

 Table 2 shows the influence of increasing 
individual PID control parameters on system response. 
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Figure 9 – PID System Response 

 

 

Table 2 – Influence of PID Control Parameters 

 

 

 

 

         

 

 
 

TUNING PID CONTROL  
PARAMETERS   

1. Verify that the TC-1 is operating correctly in open 
loop and that you have established a duty cycle 
value that results in a boost level close to your 
desired setpoint.   

2. Set initial PID parameters. Set the desired boost 
setpoint. Set the duty cycle about 5% higher (lower 
for BMW) than the value that gave the desired 
boost level in the previous open loop tests. Start 

with a low value of proportional gain, zero 
derivative gain, zero integral gain, and a deadband 
value of 120 kPa. Do a test run. Again, data 
logging will be very useful in analyzing the results 
and tuning the PID control parameters for optimum 
system response. 

3. Ignore any initial boost (MAP) overshoot. Increase 
proportional gain until some instability (oscillation) 
is observed in boost and duty cycle levels. Use no 
more than half of the proportional gain value that 
resulted in small oscillations. 

Parameter Rise Time Overshoot Settling 
Time 

Steady-
state 
Error 

Stability 

Proportional 
Gain 

Decrease Increase Minimal Decrease Degrade 

Integral Gain Decrease Increase Increase Significant 
Decrease 

Degrade 

Derivative Gain Minimal Decrease Minimal None Improve 
(for small 
values) 

Deadband Reduce Significant 
Increase 

Minimal None None 
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4. Next increase the derivative gain until boost 
overshoot is reduced. If overshoot is not an issue 
and boost seems to rise slowly, try increasing the 
deadband value.  

5. If boost error is excessive or boost drops off, try 
adding some integral gain. If oscillations are 
observed after adding modest integral gain, try 
lowering the value of proportional gain.  

6. Additional fine tuning using the same steps above 
may be required for scramble mode.  

TC-1 SOFTWARE OVERVIEW 
The  Windows software suite for the TC-1 Turbo 

Controller consists of the PC Link TC and TC Log 
programs. PC Link TC allows the user to program TC-1  
units for module parameters, duty cycle and boost 
tables, and to configure the function of the general 
purpose input/output (GPIO) terminal. TC Log software 
allows you to download data from the TC-1 unit, open 
and save files to disk, display data on a chart, and print 
chart graphics. Chart display for downloaded data 
allows you to monitor vehicle operation on the track.  

Use of the software programs is optional and not 
required for basic operation of the TC-1 system. If you 
are not planning on using the software, you can skip 
the rest of the material in this instruction manual.  

PC REQUIREMENTS 
The TC-1 connects to your PC by means of a 

USB interface. A USB cable is supplied with the unit. 
The PC must have a free USB port. If you have an 
older PC without USB capability, you cannot use the 
TC-1 software.  

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows XP/Vista/7. 
Some netbooks have inadequate resolution to display 
the entire program screens and cannot be used. Data 
chart display is graphics intensive and a high speed 
Pentium processor is recommended. Processors 
slower than 300 MHz will exhibit sluggish program 
loading and response. The PC must have a CDROM 
drive for program loading.  

PC Link TC and TC Log software include print 
commands to print downloaded data. The programs 
have been tested with Hewlett-Packard laser and inkjet 
printers and Epson inkjet printers. We recommend 
using a color inkjet printer. 

USB INSTALLATION 
The USB interface for the TC-1 is based on the 

FTDI FT232R chip and drivers that allow the unit to 
emulate a standard Windows RS-232 COM port. 
Updated Windows drivers, installation instructions and 
troubleshooting tips are available on the FTDI website 
at www.ftdichip.com.  Additional information and 
troubleshooting tips can be found on the PC Link Tech 
FAQ on our website at www.daytona-sensors.com.  

A new USB driver that simplifies the installation 
process is available. This installs as an executable file, 
similar to other Windows programs. The Windows 
Found New Hardware Wizard will then detect the USB 
device when it is first connected and automatically 
install the correct driver without the user having to 
browse out to the CDROM. 

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's PC Link Tech FAQ for details. 

1. Make sure the unit is not connected to your PC.  

2. Insert the Daytona Sensors CDROM. When the 
Daytona Sensors autorun menu appears, click on 
Software. Scroll down and click on the USB Driver 
link. When the File Download dialog box appears, 
click on "Run this program from its current 
location." Ignore any security warnings and click on 
Yes to continue.   

3. After installation of the driver is complete, connect 
the unit to the PC with the supplied USB cable. 
The Windows Found New Hardware Wizard will 
appear and complete installation of the USB 
interface.   

COM Port Configuration 
After completing the installation steps outlined 

above, you must configure the new COM port using 
Device Manager.  

1. Windows XP: click Start, Settings, Control Panel, 
System, Hardware, and then Device Manager. 
Windows Vista: click Start, Control Panel, System 
and Maintenance, and then Device Manager. 
Windows 7: Click Start, Control Panel, System 
and Security, and then Device Manager. For more 
information, visit www.pcsupport.about.com. 

2. Scroll down to Ports (COM and LPT). The new unit  
will appear as a USB Serial Port. Click on this new 
port. Click on the Port Settings tab. 
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3. Click on Advanced. In most cases the wizard will 
have installed your new unit as COM5. Note the 
COM port number assigned for your system. For 
optimum performance, you should also change the 
BM Options Latency Timer to 2 msec as shown in 
the Figure 10.  

4. Once you have configured a COM port number for 
your new unit, make sure that you use this same 
COM port selection in the TC-1 software by using 
the Port Setup command from the 
Communications menu. 

Figure 10 – COM Port Configuration 

 

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
and allows for application self-repair.  

There are two programs to install: PC Link TC and 
TC Log. Start by installing PC Link TC. If you are 
downloading software from the web, only download and 
install one program at a time. Before proceeding with 
installation, shutdown any other applications that may be 
running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are 
not familiar with the UAC, please refer to the Vista 
UAC Tech Note on our website's Tech FAQ for details.  

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in the 
PC_Link_TC  folder on the CDROM or the setup.exe file 
downloaded from our website. InstallShield will install the 
software in an appropriate folder under Program Files. 

Repeat the installation process for TC Log. Use 
the Windows Explorer or the Run command from the 

Windows Start Menu to launch setup.exe in the TC_Log  
folder on the CDROM or the setup.exe file downloaded 
from our website. InstallShield will install the software in 
an appropriate folder under Program Files. 

Once InstallShield has completed the 
installation, PC Link TC and TC Log will appear on the 
Windows Start Menu. You can then launch them just 
as you would any other Windows program.  

The programs require the Monospace 821 BT 
fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

PC LINK TC SOFTWARE 
After PC Link TC is launched, the main screen 

appears blank. You have two options for obtaining 
setup data for editing. You can open a previously 
saved setup file by using the Open Table command on 
the File menu or you can download data from an 
attached TC-1 module by using the Download From 
EEPROM command on the Communications menu. 

Note that setup files use a .dat extension. You 
should create a separate folder to store these files.   

You can edit duty cycle or boost table data by 
clicking on and dragging individual points on the chart 
display or you can directly edit numeric data on the 
spreadsheet grid.  

Once the appropriate parameters and table data 
have been entered, you can print the data using the 
Print Parameters and Table command on the Print 
Menu. You can save the edited setup file by using the 
Save Table command on the File menu.  

You can upload the setup data to an attached 
TC-1 module by using the Upload to EEPROM 
command on the Communications menu.   

A setup file (TC1_Sample.dat) is included in the 
program folder.  

DOWNLOADING DATA FROM 
EEPROM  

Turn the ignition switch on to provide power to 
the TC-1. Do not start the engine. Please note that 
the TC-1 must be powered up during PC 
communications. 
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When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

Download data by using the Download From 
EEPROM command on the Communications menu.  

If the download process is successful, the 
module parameters are displayed. You can then edit 
setup data as explained in subsequent sections.  

TC-1 units are shipped from the factory with 
default parameters and tables loaded into EEPROM 
memory. If you have never uploaded any custom setup 
file to EEPROM memory, these defaults are what you 
will see.   

UNITS SELECTION 
You can use the Units Selection command 

from the Edit menu to select pressure units.  

Figure 11 – Display Units 

 

If setup data has already been downloaded 
from the TC-1 or an existing file is open, the Units 
Selection command overrides any existing value. Note 
that pressure data is stored internally in kPa units and 
converted to the selected units for display. 

MODULE PARAMETERS  
Module parameters are displayed in a dialog box 

by using the Edit Module Parameters command on the 
Edit menu. Module parameters control the overall 
operation of the TC-1 unit. The general options and 
parameters are also accessible directly on the TC-1 via 
the user interface (LCD and encoder knob). 

When PC Link TC is first started, default module 
parameters are loaded. Module parameters are 
updated whenever you download data from a TC-1 unit 
or open a setup file. Module parameters are saved 
along with the GPIO parameters and table data when 
you save a setup file. Always check the module 
parameters before uploading data to the  TC-1.   
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Figure 12 – Module Parameters 

 
 

 

 
General Options 

Closed Loop Mode - in open loop mode the boost 
control solenoid runs at a set duty cycle. In closed loop 
mode, the boost control solenoid duty cycle varies and 
is reduced when the boost pressure exceeds the set 
point.  

RPM Based Control  - a RPM based table will be 
enabled. In open loop mode, the RPM based duty 
cycle table will be enabled. In closed loop mode, the 
RPM based boost table will be enabled. RPM based 
control can only be used if a RPM signal is connected 
to the TC-1. 

VSS Based Control  - a vehicle speed sensor (VSS) 
based table will be enabled. In open loop mode, the 
VSS based duty cycle table will be enabled. In closed 
loop mode, the VSS based boost table will be enabled. 

VSS based control can only be used if a VSS signal is 
connected to the TC-1. 

Time Based Control  - a time based table will be 
enabled. In open loop mode, the time based duty cycle 
table will be enabled. In closed loop mode, the time 
based boost table will be enabled. Time based control 
relies on an internal timer that is started based on 
parameters set on the GPIO and Timer Parameters 
dialog box described in the next topic.  

When one or more tables are enabled, the 
lowest duty cycle or boost value in any enabled 
table or value set under General Parameters is 
used.   

Scramble Enable - selecting this option enables the 
scramble feature.  

Invert Output - standard turbo systems used on most 
vehicles with the wastegate opened by boost pressure 
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require the default setting (Invert Output not selected). 
BMW turbo systems using vacuum to close the 
wastegate require the Invert Output selection.  

General Parameters 

Boost Setpoint – sets the boost setpoint (kPa units) in 
closed loop mode (scramble can be set higher) when 
no boost tables are enabled. 

Solenoid Duty Cycle - sets the solenoid duty cycle in 
percent. In open loop mode, the boost control solenoid 
will be modulated at this duty cycle (scramble can be 
set higher) when no duty cycle tables are enabled. In 
closed loop mode, this is the initial estimate for duty 
cycle prior to closed loop correction based on manifold 
pressure. If the boost set point is exceeded, the duty 
cycle will be reduced to limit manifold pressure. 
Scramble Time  - sets the scramble timeout in 
seconds. 

Scramble Boost Setpoint – sets the scramble  
manifold pressure (kPa units) in closed loop mode 
when no boost tables are enabled. 

Scramble Duty Cycle - sets the solenoid duty cycle in 
percent during scramble. In open loop mode, the boost 
control solenoid will be modulated at this duty cycle 
when no duty cycle tables are enabled. In closed loop 
mode, this is the initial estimate for duty cycle prior to 
closed loop correction based on manifold pressure. If 
the scramble boost setpoint is exceeded, the duty 
cycle will be reduced to limit manifold pressure 

The TC-1 uses a proportional-integral-
derivative (PID) control algorithm for closed loop 
control. Refer to page 12 for more details.  

Closed Loop P Gain  - proportional gain term. Higher 
values immediately reduce the boost error but may 
lead to boost instability.  

Closed Loop I Gain  - integral gain term. A zero value 
is appropriate for most drag race applications with 
short boost durations. For road race cars, some 
integral gain will reduce the boost error during 
prolonged periods of relatively steady boost and allow 
a lower value of proportional gain.  

Closed Loop D Gain  - derivative gain term. Higher 
values reduce boost spikes (overshoot of boost level 
during throttle roll-on).  

Deadband  - the boost control solenoid will remain 
energized (100% duty cycle) to bleed off feedback 
pressure until manifold pressure exceeds this value. A 
low value reduces boost spikes (the wastegate starts 

to open earlier) and a high value reduces turbo spool 
up time (the wastegate stays closed longer).   

Solenoid Frequency  - sets the boost control solenoid 
frequency in Hz. Normal values will be around 25 Hz. 
Large boost control solenoids used with twin turbo 
systems and external wastegates may require a lower 
frequency.    

LCD Contrast  - sets the TC-1 display contrast. A 
higher value causes the display to appear darker.   

Controller Scale Factors 

Controller scale factors are generally established 
during initial setup (refer to TC-1 instructions) and will 
probably remain unchanged for a particular vehicle. 
Scale factors that you can set include: 

Graph Full Scale - sets the full scale (maximum) 
graph value shown on the TC-1 display in kPa units. 
The range is 150-400 kPa. 

RPM Pulses/Rev  – RPM pulses per revolution (PPR). 
Some general guidelines follow, based on the type of 
signal connected to the RPM input: 

Tach signal. This includes aftermarket CD 
type ignitions with a tach output. In most cases 
PPR= N/2 where N is the number of cylinders. 
For example a 4 cylinder engine would require 
PPR=2 and a V8 engine would require PPR=4 

Distributor type ignition with connection to 
Coil- terminal. Same as for a tach signal. Use 
PPR= N/2 where N is the number of cylinders. 

Wasted spark coil pack (distributorless 
system) with connection to Coil- terminal. 
Use PPR=1. 

Coil on plug (no wasted spark) with 
connection to Coil- terminal or logic level 
drive signal from the ECM. Use PPR=0.5 

RPM Debounce  – RPM signal filtering in milliseconds 
(msec). Use the default value of 0.50 msec for most 
applications. Ford 4.6L modular V8 engines will require 
a value of 3.5 msec.  

VSS Frequency – sets the correct scaling for vehicle 
speed based on the signal frequency at 60 MPH. 
Values vary widely between different vehicle 
applications. Unless you have a scopemeter to 
measure the actual signal frequency, some trial and 
error using the TC Log software to display the vehicle 
speed will be required to establish the correct setting. If 
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you are not using the VSS input, you can ignore this 
parameter. 

Start with the default VSS setting. Log speed 
data while operating the vehicle at a known speed. Use 
TC Log software and download data to read the logged 
speed data. Use the following formula to calculate the 
correct scale factor: 
 
New VSS Freq  =  Original VSS Freq x Speed Reading                                 
          Actual Vehicle Speed 

 

For example, if the original VSS frequency 
parameter was 145 Hz, the speed reading is 40 MPH 
and the actual vehicle speed is 50 MPH, then the new 
VSS frequency parameter should be: 

  116 Hz  =  145 Hz x 40 MPH                                 
               50 MPH 

 
      You may have repeat this process several times for 
maximum accuracy. 

Zero TPS – throttle position sensor voltage 
corresponding to zero percent (closed) throttle. You 
can use a DVM to establish the correct setting.  

100% TPS – throttle position sensor voltage 
corresponding to wide open throttle You can use a 
DVM to establish the correct setting. The unit requires 
a rising throttle voltage where the 100% value is higher 
than the zero value. 

 

Figure 13 – GPIO and Timer Parameters 
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GENERAL PURPOSE 
INPUT/OUTPUT AND TIMER 
PARAMETERS 

General purpose input/output (GPIO) and timer 
start parameters are displayed in a dialog box by using 
the Edit GPIO and Timer Parameters command on the 
Edit menu. GPIO parameters control the function of the 
GPIO terminal on the TC-1 unit. Timer start parameters 
control the operation of the internal timer used for time 
based duty cycle or boost tables.   

GPIO and timer start parameters are updated 
whenever you download data from a TC-1 unit or open 
a setup file. These parameters are saved along with 
the module parameters and table data when you save 
a setup file. Always check the parameters before 
uploading data to the TC-1. 

 

General Purpose Input/Output (GPIO) 
Parameters 

The GPIO has five modes: 

Data Log Only - the system will log data on the GPIO 
terminal. You can log a digital signal with zero and 
+12V levels.  

Data Log Arming Input - the TC-1 will start logging 
data when a +12V signal level is applied to the GPIO 
terminal. If this mode is not selected, the TC-1 will 
continuously log data. 

Scramble Input - a +12V signal applied to the GPIO 
terminal will activate scramble mode. A momentary 
signal (from a pushbutton switch) will activate scramble 
mode for the set scramble time. A continuous signal 
will cause the TC-1 to remain in scramble mode 
regardless of the set scramble time.  

Timer Reset Input - a +12V signal applied to the 
GPIO terminal will force the internal timer used for time 
based duty cycle or boost tables to remain reset. The 
timer will start when the signal is removed and any 
other programmed timer start conditions are satisfied. 

Window Switch Output- the GPIO output will be 
active (switched to ground) whenever all the 
programmed conditions listed below are satisfied: 

Minimum Boost - minimum boost level for 
window switch output active. A value for this 
parameter is always required for the window 
switch output function. 

Maximum Boost - maximum boost level for 
window switch output active. A value for this 

parameter is always required for the window 
switch output function. 

TPS Off  - throttle position below which 
window switch output is deactivated. This 
value should always be 5-10% less than TPS 
On in order to provide some hysteresis for 
noise immunity. If TPS based window switch 
activation is not desired, tie the TPS terminal 
to +12V and use 50% for this parameter.   

TPS On - throttle position above which window 
switch output is active. This value should 
always be 5-10% higher than TPS Off in order 
to provide some hysteresis for noise immunity. 
If TPS based window switch activation is not 
desired, tie the TPS terminal to +12V and use 
90% for this parameter.   

Minimum RPM  - minimum RPM level for 
window switch output active. If RPM based 
window switch activation is not desired, enter 
zero.  

Maximum RPM - maximum boost level for 
window switch output active. If RPM based 
window switch activation is not desired, enter 
10,000 RPM.    

Minimum VSS  - minimum vehicle speed level 
for window switch output active. If VSS based 
window switch activation is not desired, enter 
zero.  

Maximum VSS - maximum vehicle speed level 
for window switch output active. If VSS based 
window switch activation is not desired, enter 
250 MPH.    

Output Delay  - delay time that window switch 
output is active once all other programmed 
conditions have been satisfied.   

Timeout - maximum time window switch 
output is active once all programmed 
conditions have been satisfied.    

Timer Start Parameters 

The internal timer used for time based duty 
cycle or boost tables will remain reset until all the 
programmed timer start conditions listed below are 
satisfied: 

Start Boost - boost level for timer start. A value for this 
parameter is always required. 

Start TPS - throttle position for timer start. If TPS 
based timer start is not desired, tie the TPS terminal to 
+12V and use 90% for this parameter.   
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Start RPM  - RPM level for timer start. If RPM based 
timer start is not desired, enter zero. 

Start VSS  - vehicle speed level for timer start. If VSS 
based timer start is not desired, enter zero. 

EDITING DUTY CYCLE AND BOOST 
TABLE DATA 

Six duty cycle and boost tables are accessible 
via individual commands on the Edit menu. The duty 
cycle tables are applicable only during open loop 
operation and the boost tables are applicable only 
during closed loop operation. RPM, vehicle speed 
(VSS), and time based tables are available. Each table 
includes nominal (normal operation) and scramble 

values. Once you have selected a table, you can edit 
the data by clicking on and dragging individual points 
on the chart display or you can directly edit numeric 
data on the spreadsheet grid. 

RPM and VSS based tables consist of 21 
columns corresponding to 500 RPM increments from 
zero to 10,000 RPM or 10 MPH increments from zero 
to 200 MPH. The 10,000 RPM or 200 MPH values are 
used at all higher levels. Time base tables consist of 
33 columns corresponding to 0.25 second increments 
from zero to 8.0 seconds on the internal timer. When 
the timer is reset, the zero values are used. The 8.0 
second values continue to be used after 8.0 seconds 
have elapsed. A typical table is shown in Figure 14.

PC Link TC is intended to be an open system 
and uses the Component One Chart 7.0 2D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 

Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link TC.  

Figure 14 – RPM Based Duty Cycle Table 
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Notes on Using Table Based Control 
Strategies  

1. RPM and VSS based tables can only be used if 
RPM and VSS signals are available and properly 
scaled (refer to Module Parameters section on 
page 16 for details). Time based tables require 
setup of the timer start parameters (refer to the 
GPIO and Timer Parameters section on page 20 
for details).  

2. As explained previously, duty cycle tables are 
applicable only during open loop operation and the 
boost tables are only applicable during closed loop 
operation.  

3. RPM, VSS, or time based tables can be 
individually enabled under General Options (refer 
to Module Parameters section for details). 

4. When one or more tables are enabled, the lowest 
duty cycle or boost value in any enabled table or 
value set under General Parameters is used. 

Editing Spreadsheet Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
the left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command.   

Figure 15 – Modify Command 

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import table data to 
or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link TC program. In the PC Link 
TC program, you can select a range of cells with the 
mouse and right click to bring up a copy and paste 

menu. When you paste data into the PC Link TC 
program, the data is automatically checked and any 
out-of-range data corrected. 

UPLOADING DATA TO EEPROM 
Refer to the Downloading Data from EEPROM 

section on page 15 for details about USB interface and 
COM port setup. Before uploading, make sure the 
parameters and tables are correct.  

Upload data by using the Upload To EEPROM 
command on the Communications menu. A status 
message is displayed when the upload process has 
been successfully completed. 

TC LOG SOFTWARE 
When launched for the first time, the program 

uses COM1 as the default port. In most cases, you will 
have configured the unit’s USB interface to use a 
different COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

After TC Log is launched, the screen initially appears 
blank. You can use the Units Selection command from 
the Edit menu to select speed and pressure units if 
your TC-1 is configured to log this data, i.e. a vehicle 
speed sensor is connected. The program will 
remember your selections. You can display data 
logged by the unit on a chart recorder type screen. 
Data logged by the unit must be downloaded before it 
can be displayed, by using the Download Data 
command on the Communications menu. Once data 
has been downloaded, it is automatically displayed on 
a chart recorder type screen. You can save the data by 
using the Save File command from the File menu after 
closing the chart display (data is not lost by closing the 
chart display). You can display a previously saved data 
file by first using the Open File command on the File 
menu and then using the View Chart command on the 
View menu. A sample data file (TC1_Sample.log) is 
included in the program folder. The sample file has 
data from a BMW 135i using the TC-1 to reduce 
excessive boost. 

UNITS SELECTION 
You can use the Units Selection command from 

the Edit menu to select speed and pressure units. Note 
that speed data is only available if a vehicle speed 
sensor is connected to the TC-1. The program will 
remember your selections. When you save 
downloaded data to a file, the units settings are saved 
along with the data. If you later open the file, the same 
units settings will remain in effect. 
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Figure 16 – Units Selection Dialog Box 

 

DATA LOGGING CHART DISPLAY 
You can display data logged by the unit on a 

chart recorder type screen. Turn the ignition switch on 
to provide power to the TC-1.Do not start the engine. 
Please note that the TC-1 must be powered up during 
PC communications. Data logged by the unit must be 
downloaded before it can be displayed, by using the 
Download Data command on the Communications 
menu. Once data has been downloaded, it is 
automatically displayed. The last data logged will 
appear at the right end of the chart. You can save 
the data by using the Save File command from the File 
menu after closing the chart display (data is not lost by 
closing the chart display). You can display a previously 
saved data file by first using the Open File command 
on the File menu and then using the View Chart 
command on the View menu. 

The data logging memory within the TC-1 stores 
the last 180,000 data points at 10 samples/second 
(default sample rate) or 100 samples/second (if the 
high speed data logging mode is selected by means of 
the PC Link TC software). This corresponds to 5 hours 
of data at 10 samples/second or 30 minutes of data at 
100 samples/sec. When you use the Download Data 
command on the Communications menu, one of the 
popup menus shown below will appear based on the 
sampling rate you have configured. You can select the 
length of the data set that will be downloaded. 

Figure 17 – Download Options Dialog Box 
(TC-1 Configured for 10 Samples/Second) 

 

Figure 18 – Download Options Dialog Box 
(TC-1 Configured for 100 Samples/Second) 

 
Note that TC-1 data files use a .log extension. 

You should create a separate folder to store these 
files. A sample data file (TC1_Sample.log) is included 
in the program folder.    

You have a range of capabilities for analyzing 
downloaded data displayed in the chart recorder 
format. 

You can select two parameters for display. 
Trace 1 is displayed in red with its Y axis legends on 
the left side of the chart. Trace 2 is displayed in green 
with its Y axis legends on the right side of the chart. 
The X axis is always elapsed time. You can zoom in, 
zoom out, or zoom all (displays entire data file). At the 
maximum zoom in level, approximately 100 data 
samples will be displayed on the chart. You can use 
the scroll bar to move the chart display window in 
terms of elapsed time. If you hold the left mouse button 
down within the chart area, a cursor line appears. The 
exact values of the parameters displayed on trace 1 
and trace 2 and the elapsed time appear in windows 
above the chart. When you zoom in or zoom out, the 
displayed data will always be centered about the 
cursor line. This allows you to quickly select and 
closely examine an area of interest. If you want to 
analyze the elapsed time between two events (for 
example the time required to accelerate from 0 to 60 
MPH), you can move the cursor to the first event and 
then click on the Reset Time Display button. You can 
print the displayed chart to any Windows printer by 
clicking on the Print button (a color inkjet printer is 
recommended for best results). Data parameters 
include: 

RPM – engine crankshaft RPM. If the RPM input is not 
connected, a zero value will be displayed. 

MAP – manifold pressure in In-Hg, kilopascals (kPa), 
or psi (29.92 In-Hg, 101.3 kPa, or 14.696 psi 
corresponds to sea level atmospheric pressure).  
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VSS – vehicle speed in MPH or KPH. If a vehicle 
speed sensor is not connected, a zero value will be 
displayed. 

TPS – throttle position (0 to 100%). If the TPS input is 
not connected, a zero value will be displayed. 

BAT – battery voltage 

GPIO – this terminal can be configured as an input or 
output for various functions with the PC Link TC 
software. When configured as an input, the level is 
displayed as a digital (on/off) signal. On means that the 
GPIO terminal is at +12V. When configured as output, 
the status is also displayed as a digital (on/off) signal. 
On means that the GPIO terminal is switched to 
ground. This is referred to as an active low output  

VALVE DUTY – boost control solenoid valve duty 
cycle (0-100%). Zero duty cycle means the valve is not 
energized. 100% duty cycle means the valve is 
constantly energized.  

INPUT 1 VOLTS, INPUT 2 VOLTS – analog input 
voltage 

INPUT 1 AFR, INPUT 2 AFR – air/fuel ratio based on 
the exhaust gas oxygen sensor reading (10:1 to 20:1). 
Only applicable if a Daytona Sensors WEGO wide-
band system has been connected to the analog inputs 

TABLE TIMER – status of the internal timer used for 
time based duty cycle or boost control. Displayed as a 
digital (on/off) signal. Off means the timer is reset. On 
means the timer is running.   

The maximum MAP, RPM and VSS values 
displayed on the chart can be set by means of 
commands on the Chart Display Edit Menu. Caution: If 
these maximum values are set lower than the actual 
logged data, the chart cursor function will not update 
the display correctly.  

Additional data is displayed at the lower right 
side of the screen. This data includes: 

Status - displays TC-1 status  

Diagnostic Code – normally blank unless a diagnostic 
code is set.  

Log Interval – the actual data logging interval in 
seconds 

You can clear the data within the unit by using 
the Clear TC-1 Data Buffer command from the 
Communications menu. If you change the data logging 
mode with the PC Link TC software, you should also 
clear the data buffer within the unit. 
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Figure 19 – Data Logging Chart Display 

 

 

IMPORTING DATA INTO EXCEL 
Data files saved from TC Log are in comma 

delimited ASCII format. Note that VSS data is scaled in 
MPH units and MAP data is scaled in kPa units. You 
can easily import a data file into other programs such 
as Microsoft Excel for further analysis. You can also 
view data files with a text editor such as Windows 
WordPad. To import a data file into Excel: 

1. Start Excel. In the File Open dialog box, select 
Files of type: All Files (*.*). Then browse for the 
data file. 

2. The Text Import Wizard appears. For step 1, select 
delimited file type. For step 2, select comma 
delimiter. For step 3, select general column data 
format. Then click on Finish. 

3. You can then format the data and save the 
spreadsheet as an Excel file. 
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APPENDIX – RECOMMENDED 
PARTS AND SUPPLIERS 

WIRE 
Wire supplied with most automotive accessories 

is usually un-tinned copper with a low number of 
strands. The unprotected copper in this inexpensive 
wire quickly oxidizes, especially when in contact with 
dissimilar metals on terminals. The low number of 
strands limits life in applications where flexing occurs. 
We recommend the use of high quality industrial grade 
wire with tinned copper strands and a high strand 
count.   

18-20 AWG sizes can be used for all signal and 
low current applications. 16 AWG is adequate for 
ground. Carol UL grade 1007/1015 wire is available 
from Digi-Key. 

P/N   Description 

C2040X-100  20 AWG wire (100 foot spool) 

C2064X-100  18 AWG wire (100 foot spool) 

C2104X-100  16 AWG wire (100 foot spool) 

C2105X-100  14 AWG wire (100 foot spool) 

Note: replace X with color code B=Black, 
W=White, R=Red, G=Green, A=Orange, 
Y=Yellow, L=Blue, N=Brown, S=Gray,  
V=Violet 

CRIMP TERMINALS 
High quality crimp terminals and a proper 

crimping tool are required to make reliable electrical 
connections. Crimp terminals commonly sold in 
automotive and hardware stores have brittle vinyl 
insulation that easily cracks. We recommend the use of 
high quality industrial grade nylon insulated crimp 
terminals. The following parts are available from Digi-
Key.       

P/N  Description 

A27241  16-20 AWG #10 ring tongue terminal 

A27246  16-20 AWG 1/4” ring tongue terminal 

A27248  16-20 AWG 3/8” ring tongue terminal 

A27262  14-16 AWG 1/4” ring tongue terminal 

A27264  14-16 AWG 3/8” ring tongue terminal 

A27288  10-12 AWG 1/4” ring tongue terminal 

A27291  10-12 AWG 3/8” ring tongue terminal 

A0911  18-22 AWG .110” female quick  
  disconnect terminal 

MNU18-187DFIK 18-22 AWG .187” female quick 
   disconnect terminal 

MNU18-250DFIK 18-22 AWG 1/4” female quick 
   disconnect terminal 

MNU14-250DFIK 14-16 AWG 1/4” female quick 
   disconnect terminal 

A1069  16-22 AWG butt splice 

A1080  14-16 AWG butt splice 

A1086  10-12 AWG butt splice 

RELAYS 
The typical import brand 30-40 amp relays leave 

little safety margin. When used to switch heavy 
inductive solenoid loads, arcing can result in the 
contacts welding together – a potentially catastrophic 
failure mode. We recommend using Tyco/P&B 
automotive OE grade relays available from Newark 
Electronics and Digi-Key. Use the 40 amp version for 
most applications and the 70 amp version for heavy 
duty applications such as fuel/nitrous solenoid 
activation. We recommend that you use the relay 
sockets and crimp terminals listed along with the 
relays.  

P/N  Description 

1432791-1 40 amp VF4 series relay 

VCF4-1001 Socket for VF4 series relay 

60249-1 12-16 AWG terminal for VF4 

VF7-41F11 70 amp VF7 series relay 

VCF7-1000 Socket for VF7 series relay 

42281-1 14-18 AWG terminal for VF4 coil 
  connections (2 required) 

280756-4 10-14 AWG terminal for VF7 
  contact connections (2 required) 

FUSES AND FUSE TAPS 
ATC series fuses and fuse holders commonly 

used for automotive applications are only available in 
40 amp and lower ratings. For high current 
applications, we recommend the heavy duty 50 amp 
Littlefuse Maxi Fuse series available from Digi-Key.     

P/N  Description 

F1085  Maxi fuse block 

F1038  50 amp Maxi fuse 

 

SWITCHES 
All switches used in performance applications 

should be sealed. Representative sealed toggle and 
rocker style switches available from Digi-Key are listed 
below.     
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P/N  Description 

480-2191 Honeywell SPDT toggle switch 

360-2278 NKK SPDT rocker switch 

RELIABLE CONNECTIONS TO EXISTING 
SIGNALS 

For some applications, you may have to tap into 
existing signal wires on the vehicle. We caution against 
using any of the so called “vampire clips” that make an 
insulation displacement connection. These have 
proven very unreliable in racing applications. They may 
even cause the original wire to fray and break. We 
suggest soldering any connections to existing signals. 
Use a stripping tool to cut through and push back 
about 1/4” of insulation at the spot on the original wire 
where you plan to make the connection. Wrap several 
turns of the new wire around, solder, insulate with self 
vulcanizing electrical tape, and use two cable ties to 
secure the splice as shown. Regular electrical tape will 
tend to unravel. Self vulcanizing electrical tape is 
available from Digi-Key as their P/N W213.    

 

SUPPLIERS 
Suppliers referenced in the Appendix are listed 

in the table below. Additional suppliers for connectors, 
electronic tools, mechanical hardware, and test 
equipment are listed on our website at     
www.daytona-sensors.com/tech_tools.htm. 

 

Supplier Phone Website 

Digi-Key 1-800-344-4539 www.digi-key.com 

Mouser 1-800-346-6873 www.mouser.com 

Newark 1-800-463-9275 www.newarkinone.com 

State Wire 
& Terminal 

1-800-922-6527 www.statewire.com 


